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Chapter 1
Computer – A Wonder Machine

Activity Time
Before we learn more about the wonder machine called ‘Computer’, 
let’s have a quick revision. Given on the next page are some 
sentences that describe the qualities of a computer and a human 
being. Connect each sentence with different coloured lines to the 
correct box.
	 Ans.	 Computer: 1. I am a machine. 2.  I don’t make mistakes.
		  3. I can remember everything for a long time. 4. I am very fast.
		  Humans: 1. I can think and decide. 2. I may forget. 3  I get tired.

Do it Yourself

Help the stylus find its way to the correct computer for it.
	 Ans.	  
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Do and Learn

1.	 Circle only the computers.

	 Ans.	

2.	� Look at the given picture and answer the questions that follow.
	Ans.	 1.	 How many computers do you see in the picture?	  6
	 	 2.	 How many smartphones can you find in the room?	 3
		  3.	� Can you see a laptop in the room? Yes. If yes, how many? 1
		  4.	 What parts of a desktop computer can you see? Name them.
			   (a) Monitor  (b) Mouse (c) Keyboard (d) CPU

3.	 Match the following:

Ans.	 1.	 	 (i)	 Smartphone

2.	 	 (ii)	 Supercomputer

3.	 	 (iii)	 Laptop

4.	 	 (iv)	 Palmtop

5.	 	 (v)	 Desktop
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 4.	  Draw  if correct and  if incorrect.
	 	 (a)  Desktop is a computer that is fixed at one place and is not easy 
			   to move. 
		  (b)  Palmtops are very big computers. 

		  (c)  Some tablets come with a stylus.	
	 	 (d)  Supercomputers are used for doing very difficult jobs. 
		  (e)  Laptops can work with electricity only. 

5.	 Tick () the correct option.
(a)	 A computer that is fixed at one place.

	 (i)	 Laptop				  

	 (ii)	 Palmtop				  

	 (iii)	 Desktop				    

(b)	 Computer that can also be used like a mobile phone.
	 (i)	 Smartphone				    

	 (ii)	 Desktop				  

	 (iii)	 Supercomputer				 

(c)	 A computer that is very big in size.
	 (i)	 Laptop				  

	 (ii)	 Supercomputer				   

	 (iii)	 Desktop				  

(d)	 A computer that can be carried in a pocket.
	 (i)	 Supercomputer				 

	 (ii)	 Desktop				  

	 (iii)	 Smartphone				    
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(e)	 A type of computer that is generally kept on a desk.
	 (i)	 Supercomputer				 

	 (ii)	 Desktop				    

	 (iii)	 Palmtop				  

Computer Time

Open the Paint program and draw and colour a child using a 
computer. This picture may help you!
	Ans.	 Do it yourself.

Answers of Suggested Class Activities
A. 	Number of desktops: 5;  Number of tablets: 4;  Number of laptops: 3; 

Number of smartphones: 4
B. 	1.	 True  2. False  3. False  4. False  5. True  6. False
C. 	1.	� At banks, computers help people to keep money and take it out 

when required.
	 2.	� At railway stations, computers are used to print tickets. You can 

also book tickets through a computer from home.
	 3.	� At weather centres, computers are used to tell about how the 

weather is going to be like.
	 4.	� Computers are used for sharing news at television stations.
	 5.	� At hospitals, doctors use computers to check patients. They can 

learn more about diseases through computers.

Answers of Worksheet

	 I.  	 1. portable  2. immovable  3. hospitals  4. larger
	 II.  	 1. (c)  2. (d)  3. (a)  4. (e)  5. (b)
	 III.  	 1. d r a w; p a i n t  2. t i r e d   3. s a m e  4. g a m e s
	 IV.  	 1.   2.   3. 
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Chapter 2
Using the Computer

Do it Yourself
Rearrange the following steps in the correct order of starting the 
computer.
	 Ans.	 1.	 Turn on the main power switch.
		  2.	 Switch on the UPS.
		  3.	 Switch on the power button on the CPU box.
		  4.	 Switch on the monitor.

Do and Learn

1.	 Draw  if you agree with the action in the picture and  if 
you don’t agree.

	 Ans.	
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	 2.	 Tick () the correct option.
		  1.	 First step in starting the computer is:
	 (i)	 Switching on the monitor	

	 (ii)	 Switching on the main power button	 

	 (iii)	 Switching on the UPS	
		  2.	 Last step in shutting down the computer is:

	 (i)	 Switching off the CPU	

	 (ii)	 Switching off the main power button	 

	 (iii)	 Switching off the UPS	
		  3.	 Which of the following is not a correct or right action?

	 (i)	 Eating food while working on the computer	

	 (ii)	 Pushing the keys of the keyboard very hard	

	 (iii)	 Both of these		  

		  4.    You are a good computer user if:

	 (i)	 You clean the computer with a wet cloth.		

	 (ii)	 You clean the computer with clean and dry 
cloth.	 

	 (iii)	 You never clean the computer.		

3.	 Rearrange the letters to make correct words and write them in 
the blanks.

	 Ans.	 O O B T N I G			   BOOTING
		  T A R T S			   START
		  U S H T D W O N			  SHUTDOWN
		  O W E P R			   POWER
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Answers of Suggested Class Activities
A. 	1. (c)  2. (a)  3. (b)
B. 	1. dry  2. care  3. shut down  4. Close  5. power

Answers of Worksheet
	 I.  	 1. (b)  2. (b)  3. (d)  4. (d)
	 II.  	 1. (c)  2. (d)  3. (a)  4. (b)
	 III.  	 1. False  2. True  3. True  4. True  5. False
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Chapter 3
Parts of a Computer

Do it Yourself

From the following word grid, find out the names of computer 
parts given in the cloud.
	 Ans.	 A S S C A N N E R U

X V P T L B X E D K
P J E V T M O U S E
S G A P W B M C L Y
C R K A A A A I E B
P B E C N X Z D T O
U R R E W N A O E A
T S S B G J P J Z R
E P R I N T E R U D
X B M O N I T O R A

Activity Time

Match the following.

	 1.	 Typing			   (a)	

	 2.	 Printing on paper			   (b)	

	 3.	 Listening to music			  (c)	

	 4.	 Recording my voice		  (d)	
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Do and Learn

1.	 Join the dots and complete the pictures of the following 
computer parts. Also, colour the pictures.

	 Ans.	 Do it yourself.
2.	 Suggest the computer part to be used in the following cases.
	 Ans.	 (a)	 Shaurya sings beautifully. He wants to record his song and 

save it on the computer. MICROPHONE
		  (b)	 Anamika’s friend stays in USA. She wants to talk to her as 

well as see her while talking. WEB CAMERA
		  (c)	 Parnika has done her homework using the computer at 

home. She wants to copy the homework and take it to 
school to show it to her teacher. PEN DRIVE

		  (d)	 Jayati wants to take a printout of the poem she has typed on  
the computer. PRINTER 
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3.	 Draw  if correct and  if incorrect.
		  (a)  A printer can record your voice. 
		  (b)  A DVD is played in the DVD drive. 
		  (c)  A pen drive is very big in size. 
		  (d)  UPS is also called CPU. 
		  (e)  Speakers help you listen to sound from the computer. 

Answers of Suggested Class Activities
A. 	1. Monitor  2. Printer  3. Speakers  4. Keyboard  5. Mouse
B. 1. �Printer: A printer helps you copy information from the computer 

onto paper.
	 2.	 Webcam: A webcam is used to transfer images or videos to the  
		  computer.
	 3.	 UPS: UPS stands for Uninterrupted Power Supply. It is a computer  
		  part that helps your computer to keep on working even when the  
		  electricity goes off.
	 4.	 CD/DVD: These are round-shaped shiny discs that can save  
		  your work on the computer. You can copy the work from the CD/ 
		  DVD to another computer.
C. 	1. Monitor, keyboard, mouse, speakers, CPU box.
	 2.	 Keyboard.
	 3.	 Mouse.
	 4.	 CPU or Central Processing Unit is the brain of the computer.
	 5.	 Monitor.

Answers of Worksheet
	 I.  	 1. four  2. 104  3. listen  4. Microphone  5. flash drive
	 II.  	 1. False  2. False  3. True  4. True  5. True
	 III.  	 1. (a)  2. (a)  3. (a)  4. (b)  5. (a)
	 IV.  	 1. (b)  2. (d)  3. (a)  4. (c)  5. (f)  6. (e)
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TESTING TIME 1
(Based on Lessons 1 to 3)

1.	 Fill in the blanks by choosing correct words form the cloud.
	 Ans.	 (a)	A Supercomputer is a very big and powerful computer. 
		  (b)	A computer that is also used for making phone calls is called a 
			   Smartphone. 
		  (c)	A Printer is part of the computer that is used for printing. 
		  (d)	Speakers are a part of a computer that produce sound. 
		  (e)	Making the computer ready to work is called booting.

2.	 Colour the computer parts that are necessary to work on a 
computer with red colour and the parts without which you 
may still be able to work on a computer, with blue colour.
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	 Ans.	 Do it yourself.

3.	 Fill in the blanks to complete the steps to switch on a computer.
	 Ans.	 (a)	Switch on the power supply. 
		  (b)	Switch on the UPS. 

		  (c)	Switch on the CPU. 

		  (d)	Switch on the monitor. 

4.	 Write five points that you should avoid doing when using a 
computer. One has been done for you.

	 Ans.	 (a)	I should not eat or drink near the computer.
		  (b)	I should not touch the wires of the computer.
		  (c)	�I should not fight with anybody while working on the 

computer.
		  (d)	I should not clean the computer with a wet cloth.
		  (e)	I should not press the keyboard keys very hard.
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Chapter 4
More About the Keyboard

Do it Yourself

Label the keys in the following keyboard.

Number Keys

Caps Lock Key

Alphabet Keys Enter KeySpacebar

Do it Yourself
Help Aanya type the following. Remember to keep the Caps Lock key 
off while typing.
	 Ans.	 Do it yourself.

Computer Time

With the help of your teacher, open the Notepad program and follow 
these steps.
	 Ans.	 Do it yourself.
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Activity Time
Fill in the names of the blank keys.
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~
'

 !
1

 @
2

 #
3

$
4

 %
5

^
6

 &
7

 *
8

(
9

 )
0

—
–

+
=

 Backspace

Enter

ShiftShift

Caps Lock

F1 F2 F3 F4 F5 F6 F7 F8 F9 F10 F11 F12 PrtScn PauseScroll
Lock

Num 
Lock

7 
Home

8 


2 


5 

1 
End

9 
PgUp

3 
PgDn

Enter

+

. 
Del

0 
Ins

/ * –

SysRq

Insert

CtrlCtrl

Tabs

AltAlt 

Delete

Z

A

Q

X C

S

W

D F

E

V

R

B

G

T Y

N

H

M

J

U

K L

I O P

"
'

:
;

Page 
Up

Page 
Down

Break



 

\
}
]

{
[

?
/

>
.

<
,

Home

End

Computer Time
Use the numeric keypad to type the following.
	 Ans.	 Do it yourself.

Do and Learn
	 1.	 Tick () the correct option.
		  (a)	�To type the symbol $, we press the  key along with which 

key?
	 (i)	 Enter key	 	 (ii)	 Shift key	  	 (iii)	 End key	

		  (b)	The key that takes you to the beginning of a sentence.

	 (i)	 Esc 	 	 (ii)	 Home 	  	 (iii)	 End 	

		  (c)	�When this key is on, we can type numbers from the numeric 
keypad.

	 (i)	 Caps Lock	 	 (ii)	 Shift	 	 (iii)	 Num Lock	 

		  (d)	This key helps to exit a program.
	 (i)	 Esc	  	 (ii)	 Shift	 	 (iii)	 Home	

	 2.	 Draw  if correct and  if incorrect.
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	 Ans.	 (a)  All computer keyboards are black in colour. 
		  (b)  I will press the End key if I have to move the cursor to the  
			   start of a line. 
		  (c)  The numeric keypad is present on the left of the keyboard.  
				  

		  (d)  When Num Lock key is OFF, we can use the arrow keys. 
		  (e)  There are two Shift keys on the keyboard. 

4.	 Rearrange the jumbled letters to write the correct names of 
the keys in the blanks.

	 Ans.	 (a)	UMN LOKC		  NUM LOCK
		  (b)	SEC 		  ESC
		  (c)	NDE		  END
		  (d)	OHEM 		  HOME
		  (e)	HIFST		  SHIFT

Answers of Suggested Class Activities
A. 	Do it yourself.
B. 1. (b)  2. (d)  3. (a)  4. (e)  5. (d)
C. 1. Caps Lock key  2. Delete key  3. Backspace key  4. Spacebar
	 5.	 Enter key.

Answers of Worksheet
	 I.  	 1. (b)  2. (d)  3. (a)  4. (c)
	 II.  	 1.	 10
		  2.	 Spacebar, Caps Lock, Backspace, Enter.
		  3.	 26  4. One  5. The right arrow ( ) key.
	 III.  	 1. Cursor  2. Spacebar  3. Down arrow  4. Up arrow  5. Enter
	 IV.  	 1. (e)  2. (d)  3. (a)  4. (c)  5. (b)
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Chapter 5
How Computers Work

Activity Time
	 Ans.	 Do it yourself.

Think and Tell!
Let us suppose that you put dirty clothes and water into the 
washing machine and start the machine. It washes the clothes.  
However, when you take out the clothes, they look dirty. What 
went wrong?
	 Ans.	  Was the machine not working properly?
			   The machine was working properly.
		   Did you forget to put something?
			   Yes.
		   If yes, what was it?
			   Detergent powder.
		   Whose mistake was it?
			   Mine.

Activity Time
Write I for input, P for process and O for output in each of the 
following examples. They may not be in the correct order.
	 Ans.	

1.

I O P

	

2.

I O P
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3.

I P O

Do and Learn

1.	 Put () if the following outputs are correct and () if they are 
incorrect.

	Ans.	 (a)	 2 + 1 = 3	  	 (b)	 3 + 4 = 6	  	 (c)	 6 – 1 = 4	 

		  (d)	 2 – 1 = 1	  	 (e)	 1 + 5 = 6	 

2.	 Tick () the correct option.
	Ans.	 (a)	Giving information to the computer is called:
	 (i)	 Process				  

	 (ii)	 Input				    

	 (iii)	 Output				  

		  (b)	GIGO stand for Garbage in, Garbage .
	 (i)	 On				  

	 (ii)	 Off				  

	 (iii)	 Out				    

		  (c)	�A computer shows the output on which of the following 
computer parts?

	 (i)	 				    

	 (ii)	      				  
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	 (iii)	 				  

		  (d)	It is not used for giving input to the computer.

	 (i)	 				  

	 (ii)	 				    

	 (iii)	 				  

3.	 Your mother gave you cut fruits and some other things to 
make fruit chaat. Write the steps you followed.

	 Ans.	 (a)	Input: Sprinkle chaat masala and a few drops of lemon  
			   juice.
		  (b)	Process: Mix everything well.
	 	 (c)	Output: Put the chaat in a bowl and it is ready to serve.

Answers of Suggested Class Activities
A. 	 Input		 Output
	 2.	 Water, electricity		  Hot water
	 3.	 Corn		  Popcorn
	 4.	 Iron, electricity, clothes		  Ironed clothes
	 5.	 Washing machine, water,		  Clean clothes
		  detergent, electricity, dirty
		  clothes
B. 	1. (b)  2. (b)  3. (a)
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Answers of Worksheet

	 I.  	 1. input  2. output  3. data  4. numbers; symbols
		  5.	 pomegranate; juicer
	 II.  	 1. False  2. False  3. True  4. True  5. False
	 III.  	 1. The three-step process used by the computer is called the input, 

process, output cycle or IPO cycle.
		  2. CPU.
		  3. Monitor.
		  4.	 Keyboard.
		  5.	 Data is what we provide to the computer through a keyboard. 

It forms the input given to the computer.
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Chapter 6
Typing with Notepad

Activity Time

Draw arrows and write the names of the different parts of the 
Notepad window given below.
	 Ans.	 Menu Bar Title Bar

Cursor

Text Area

Computer Time

Open Notepad and type the text shown in the box below.
	 Ans.	  Do it yourself.

Computer Time

Open Notepad and type the following sentence:
Aanya and Shurya are classmates and friends.

	 Ans.	  Do it yourself.

Do and Learn

1.	 Fill in the blanks using words from the hint cloud.
	 Ans.	 (a)	Notepad is a typing program. 
		  (b)	The Notepad program is present in Windows 
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Accessories.	
		  (c)	The topmost bar of the Notepad window is the Title bar. 	
		  (d)	File menu of Notepad has the Save command. 
		  (e)	The area where we type is called the Text area. 

2.	 Rearrange the following steps in the correct order to start the 
Notepad program.

	 Ans.	 (a)	Click the Windows button ( ).
		  (b)	In the search text box, type ‘Notepad’.
	 	 (c)	 In the search results, click the Notepad program or press 

Enter.
	 	 (d)	The Notepad window opens.

3.	 Draw  if correct and  if incorrect.
	 Ans.	 (a)  Notepad is a program used for drawing and colouring. 
		  (b)  Notepad is present in the Accessories folder. 
		  (c)  We cannot change the size of the text after typing in Notepad. 
	 	 (d)  We need to click the Edit normal menu to save a file. 
		  (e)  The Title bar shows the name of the program. 

Activity Time

There are some jumbled up sentences in this Jungle Book picture. 
Make correct sentences and write them below.  Also, type them in 
Notepad and save your document.
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Is big Baloo.

Mowgli am I.

Saved Bagheera 
Mowgli.

Khan Sher king 
is the.

	 Ans.	 (a)	Baloo is big.
		  (b)	I am Mowgli.
		  (c)	Bagheera saved Mowgli.
		  (d)	Sher Khan is the king.

Answers of Suggested Class Activities

A.  Menu Bar Title Bar Window Controls

Scrollbars

File Name

Cursor

Text Area
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B. 	1.	 Notepad.  2. File menu.  3. Edit menu.  4. Format menu.
	 5.	 Title bar.
C. 	1. Ctrl + N  2. Ctrl + S  3. Ctrl + O  4. Ctrl + C  5. Ctrl + V

Answers of Worksheet

	 I.  	 1. font style; font size  2. line  3. typing  4. Scroll bar
	 II.  	 1.	 To open Notepad, follow these steps:
			   (a)	 Click the Windows key ( ).
			   (b)	 In the search text box, type ‘Notepad’.
			   (c)	 In the search results, click the Notepad program or press 

Enter.
			   (d) The Notepad window opens.
		  2.	 After typing the text in Notepad, we can change the size or 

style of the text or font according to our need. Let’s learn how 
to do this by following these steps:

			   (a) Click the Format menu on the Menu bar.
			   (b) �Select the Font option. The Font dialog box opens on the  

	  screen.
			   (c) Select the font, font style and size of your choice.
			   (d) Click the OK button and notice the change in the text.
		  3.	 Closing Notepad
	 	 	 (a)	�Before closing Notepad, save any files that you may have 

opened. Now, click the File menu.
			   (b)	Select the Exit option. The Notepad program will close.
				    You can also click the cross button (close button) on the right 

side of the window.
	 III.  	 1. False  2. False  3. True
	 IV.  	 1. Title bar  2. Menu bar  3. Text Area  4. Scroll bar  5. Cursor



132 Living with Computers 2 TRM

TESTING TIME 2
(Based on Lessons 4 to 7)

1.	 From the following word grid, find names of any five keyboard 
keys and write their names in the given space.

	Ans.	 E N T E R Q E T Y U
X V E T L B X E D K
P J N S M H O M E J
S G O P W B M C L S
H R Y A Y T U I E V
I B M C N X Z D T E
F R L E W N A O E D
T S V B G J P J Z A
E S C A Z X Q T U O
X B V R D W Q E N D

2.	 Write whether each of the following is Input, Process of Output.
	Ans.	 (a)	 Cool air coming from an air conditioner.	 Output

		  (b) Boiling of tea in the teapot.	 Process

		  (c)  Entering numbers in the calculator for adding.	 Input

		  (d) Sound coming from speakers.	 Output 

		  (e) Putting food in the microwave for heating.	 Input

3.	 Navya has typed the following text in Notepad. Read it and 
answer the following questions.

	Ans.	 (a)	 Underline the words where Caps Lock is on.  (GROWING)
		  (b)	� Circle all the symbols (not numbers and letters) used in the 

text.	 (“ ’’, & ,’ and ,)
		  (c)	Count and write the number of times full stop is typed. (6)



133Living with Computers 2 TRM

		  (d)	� Write the line number in which the full stop is not typed at 
the end of the sentence. (Line no. 5)

		  (e)	� While typing this text, how many times did Navya pressed 
the Enter key? (6 times)

4.	 Tick () the correct option and write it in the blank.

	Ans.	 (a) The Home key moves the cursor to the beginning of a line. 
		  (b) In the IPO cycle, P stands for Process.
		  (c) Notepad is a computer program used for typing.
		  (d) Processing is done by CPU.
		  (e) The Save option is part of the File menu in Notepad.
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Chapter 7
More About Paint

Activity Time
Name any three Paint tools used to draw the following picture.
	 Ans.	 	 Rectangle tool

Oval tool

Pencil tool

1.

2.

3.

Computer Time

The following picture shows different polygons drawn using 
the Polygon tool. Draw these in Paint and show them to your 
teacher.

	 Ans.	 Do it yourself.



141Living with Computers 2 TRM

Computer Time

Draw the picture shown using the Paint program.

Save Trees

	 Ans.	 Do it yourself.

Computer Time

Open Paint and draw the picture shown below. You may change 
the colours if you want.

	 Ans.	 Do it yourself.
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Do and Learn!

	 1.	 Fill in the blanks by choosing words from the options 
given.

	 Ans.	 (a)	A pentagon (a five-sided shape) can be drawn with the help 
	 	 	 of the Polygon Paint tool. 

	 	 (b)	A rectangle with rounded corners can be drawn with the  
			   Rounded rectangle tool. 

	 	 (c)	In Paint, I will use the Text tool if I want to include text in my  
	 	 	 drawing. 

	 	 (d)	To save a drawing in Paint, click the File menu. 

	 2.	 Draw  if correct and  if incorrect.
	 Ans.	 (a)	Polygon tool is used to draw a rounded rectangle. 

	 	 (b)	In Paint, the Curve tool is present in Tools group. 
	 	 (c)	The Text tool is used for typing. 
	 	 (d)	If you want to pick a colour from your drawing, use the Brushes  
			   tool. 
	 	 (e)	The Rounded rectangle tool draws a rectangle with pointed  
			   corners. 

	 3.	� Sargun wants to draw a nice scenery using the Paint 
program. Can you suggest which Paint tools he can use to 
do each of the following?

	 Ans.	 (a)	 Draw a line while making a hut.	 Line tool
	 	 (b)	 Draw a circle for the sun.	 Oval tool
	 	 (c)	 Draw flowers of different shapes.	 Brush tool
	 	 (d)	 Fill yellow colour in the sun.	 Fill with Color tool
	 	 (e)	 Erase any mistakes made in the scenery.	 Eraser tool
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Computer Time

Open the Paint program and draw the following picture.

	 Ans.	 Do it yourself.

Answers of Suggested Class Activities
A. 	1. Fill with color  2. Eraser  3. Rectangle  4. Brushes  5. Text
B. 	1. Oval tool  2. Shapes (star) tool
 	 3.	 Shapes (thunderbolt) tool  4. Shapes (heart) tool
	 5.	 Shapes (diamond) tool

Answers of Worksheet

	 I.  	 1. Text  2. Color Picker  3. fill large enclosed areas with colour
		  4.	 attractive  5. File
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	 II.  	 1. MS Paint is a special computer program that helps us draw and 
fill colours into drawing.

		  2.	 Star, Triange, Diamond.
		  3.	 The text tool is used to insert text in our drawings.
		  4.	 This tool is used to fill colour in an enclosed shape.
		  5.	 �The Drawing area is the part of the Paint window where we 

actually make our drawings.
	 III.  	 1. False  2. False  3. False  4. True  5. False
	 IV.  	 1. Polygon tool
		  2. Text tool
		  3. Color Picker
		  4.	 Rectangle tool
		  5.	 Eraser tool
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Chapter 8

Computer Storage

Activity Time

Test your memory by answering these questions.
	 	 1.	 What is your best friend’s name?	
		  2.	 What is your mother’s best friend’s name?	
		  3.	 Which hotel did you stay in when you went on vacation with  
			   your parents two years back?	
		  4.	 What is your neighbour’s phone number?	
	 Ans.	 Do it yourself.

Do and Learn

	 1.	 Fill in the blanks.
	 Ans.	 (a)	 A computer’s brain is known as MEMORY.
		  (b)	 A computer stores things in its memory with the help of  

STORAGE devices. 
		  (c)	 CD stands for COMPACT Disc. 
		  (d)	 A DVD looks like a CD.
		  (e)	 A pen DRIVE can be easily carried in a pocket.
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	 2.	 Match the following.

(a)	 	 (i)	 Pen drive

(b)	 	 (ii)	 Hard disk

(c)	 	 (iii)	 CD

3.	 Look at the given picture carefully and write the following.
	 Ans.	 (a) Number of pen drives :   4  
		  (b)	Number of CDs/DVDs :   7  
		  (c)	Number of keyboards :   1  
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Answers of Suggested Class Activities
A. 	1. Moserbaer; Writex  2. Sony; Panasonic  3. Sandisk; Kingston
	 4.	 Western Digital; Seagate Technology  5. Sony; Maxwell
B. 1. Floppy disk  2. CD  3. DVD  4. Blu-ray disc
C. 	Colour the ‘Hard disk’ and ‘Pen drive’ clouds.

Answers of Worksheet

	 I.  	 1. 7  2. 10  3. 5

	 II.  	 Y A H A R D D I S K M U Y J R E L H

E H J V A Z V Q F L O P P Y D I S K

B Y W D M Y D S O U F E E M A I T R

H W T X Y C S M H J V N S C M K O M

E B B G M C V C G D C D V Y P W R P

V C T X A H T G K Y L R C Y V B A D

J W Y E B Y L O V D G I L D C J G H

H X R D Y U D Z D S A V E D O T E F

I W Z C A I O S A X M E M O R Y G O
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TESTING TIME 3
(Based on Lessons 7 and 8)

	 1.	 Match the following:

		  1.	     			   (a) Color Picker tool

		  2.	 A 			   (b) Polygon tool

		  3.	 			   (c) Rounded Rectangle tool

		  4.	 			   (d) Text tool

	 2.	 Who am I?
		  (a)	 I can help you type your name on your drawing	  
			   in Paint.	 Text tool

		  (b)	 I am a storage device having a round shape and a storage  
			   capacity more than that of a CD.	 CD/DVD		

		  (c)	 I am the computer’s brain.	 Memory		

		  (d)	 I store information inside the CPU box.	 Hard disk		

		  (e)	 I am a Paint tool and I help you make curved	  
			   drawings.	 Curve tool		

3.	 Nitya has made a nice drawing in the Paint program. She wants 
to write her name and class on the drawing. Can you suggest 
the Paint tool she should use?

	 Ans.	 Text tool.
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4.	 Saumya wants to copy a cartoon movie from her computer and 
give it to her friend in school. Which storage device should 
she use?

	 Ans.	 CD/DVD/Pen drive.

PROJECT WORK
	Ans.	 Do it yourself.
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